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Introduction

About this Guide
This guide contains detailed information about installing and licensing
Autodesk® Smoke®2012 for Mac OS® X. The document also contains general
guidelines about preparing your workstation and operating system before you
install the Smoke software.

This document assumes that you have regular user knowledge of Apple®

workstations and Mac OS X. You do not need prior knowledge of Autodesk
Visual Effects and Finishing software.

Contacting Customer Support
You can obtain support for Smoke on the Mac by making a Service Request at
the Autodesk Subscription Center (registration required).

Go to http://www.autodesk.com/subscriptionlogin. Once logged into your account
at the Subscription Center, select "Support Requests".

Customer support is also available through your Autodesk reseller. To find a
reseller near you, consult thereseller look-up database at ht-
tp://www.autodesk.com/resellers.

Before contacting Autodesk Customer Support, run the platforminfo
command-line utility to gather important information on your system.

To obtain system information:

1 Open the Terminal from the Applications / Utilities folder.

2 Type the following command:

1

1

http://www.autodesk.com/subscriptionlogin
http://www.autodesk.com/resellers
http://www.autodesk.com/resellers


platforminfo

The output looks similar to the following:

Workstation: MacPro4,1

CPU: 2 Quad-Core Intel Xeon @ 2.93 GHz, 8 cores

RAM: 20 GB of RAM

Graphics: NVIDIA Quadro FX 4800 Driver: 256.01.00f03

OS: Mac OS X 10.6.6(10D561)

Kernel: Darwin 10.6.0

3 Send this information to Autodesk Customer Support.
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Preparing Your
Workstation

Preparing Your Hardware
Before you set up your workstation, consult the Autodesk Smoke for Mac OS X
System Requirements Web page at www.autodesk.com/smoke-systemrequirements,
and make sure your hardware meets the minimum requirements for your version
of Smoke for Mac OS X.

Consult your hardware documentation for information on how to install the
necessary add-on cards in your system (such as the NVIDIA® graphics card, and
the AJA Kona card), and how to connect your workstation to the peripherals
you want to use it with (such as a pen tablet, graphics monitor, broadcast
monitor, or VTR).

Preparing Your Media Storage
Before configuring storage to work with Autodesk Smoke, contact your storage
vendor to make sure your storage fulfills the requirements for the frame format
you will be working with.

Remember that, in order to ensure the best quality results, Autodesk Smoke
does not apply compression to rendered intermediates. This means that the
storage bandwidth requirements are higher than those for applications that use
compressed media. Select the appropriate storage solution to achieve sustained
real-time playback.

Consult the Autodesk Smoke for Mac OS X System Requirements Web page at
www.autodesk.com/smoke-systemrequirements for guidelines about the throughput
your storage should support for various frame formats.

2
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Consult your vendor documentation for information on connecting the media
storage disks to your Mac, and on using the Mac OS X Disk Utility to perform
the RAID striping of your media storage device.

Recommended File System

For optimal performance, Autodesk recommends using the default Mac OS
Extended Journaled (HFS+) file system, for your system drive and your media
storage volume.

Use the Mac OS X Disk Utility to format your media storage volume to the
recommended file system. Consult your Mac OS X documentation for
information.

Updating Your Operating System
Consult the Autodesk Smoke for Mac OS X System Requirements Web page
at www.autodesk.com/smoke-systemrequirements for information on the version
of the Mac OS X operating system required for Autodesk Smoke.

To find out which version of Mac OS X your workstation is currently running,
select About this Mac from the Apple menu. The version number appears
below the Mac OS X heading.

If your workstation is not running the required version of Mac OS X, click
Software Update to upgrade your operating system.

WARNING Do not update your operating system or hardware drivers to versions
other than the ones recommended by Autodesk. Ignore any updates offered by
the Apple Software Update utility, unless instructed otherwise by Autodesk.

Installing or Updating Hardware Drivers
Before installing Smoke, install or upgrade the drivers for your hardware
devices.

Consult the Autodesk Smoke for Mac OS X System Requirements Web page
at www.autodesk.com/smoke-systemrequirements for information on the supported
driver versions.

4 | Chapter 2   Preparing Your Workstation
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You can update some of the drivers, such as the NVIDIA graphics card driver,
through the Apple Software Update utility. To get drivers that are not installed
by the Software Update utility (such as the AJA Kona video card driver, or the
Wacom® pen tablet driver), refer to the Web site of your hardware device
vendor.

WARNING Do not install any driver versions other than the ones recommended
by Autodesk. Ignore any driver updates offered by the Apple Software Update
utility, unless instructed otherwise by Autodesk.

Setting System Preferences
Open the System Preferences application, and set the following options as
indicated in the table below.

WARNING These settings are mandatory and will prevent Smoke from working
correctly if they are not set as documented.

NOTE These system preferences are set per Mac OS X user account. Make sure
you apply them to all the Mac OS X user accounts you plan to use with Smoke.

Option to ModifySystem Preference

In the Screen Saver tab, set Start screen saver to Never.Desktop & Screen Saver

Energy Saver ■ Set Computer sleep to never.

■ Disable Put the hard disk(s) to sleep when possible.

Depending on current location of control surface Ethernet connection,
Set Network interface to Ethernet Port 1 or Ethernet Port 2.

Euphonix (if applicable)

In the Keyboard tab, enable Use F1, F2, etc. keys as standard function
keys.

Keyboard

In the Privacy tab, add the Smoke media storage volume to the list of
locations Spotlight does not search.

Spotlight

In the Scheduled Check tab, disable Check for updates.Software Update
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Option to ModifySystem Preference

NOTE Before installing Mac OS X or QuickTime® updates, consult the
Autodesk Smoke for Mac OS X System Requirements Web page at
www.autodesk.com/smoke-systemrequirements, to see if these updates are
compatible with the installed version of Smoke.

In the Output tab, make sure the device selected for sound output is
not the AJA card.

Sound

Select, for example, Internal Speakers, or Line Out.

Configuring Your Network
Smoke for Mac OS X supports both static IP and DHCP network configurations.

If your Mac uses DHCP to obtain its hostname or IP address, make sure the
hostname and IP address assigned to your computer do not change when the
DHCP lease is renewed.

WARNING If the hostname or IP address of your Mac change while Smoke is
running (for example, if your Mac switches from a wired network to a wireless
connection), close Smoke and restart your computer, to avoid any issues with the
application.

Configuring Mac OS X Keyboard Shortcuts
The Smoke application uses many keyboard shortcuts that are also used by
Mac OS X.

As a general guideline, make sure your operating system does not use any
single-key shortcuts (such as F1, F2, etc.) or shortcuts that include the CTRL
and OPTION key modifiers, as these could overlap with Smoke hotkey
combinations.

It is recommended to include the COMMAND key when defining OS-level
shortcuts, as Smoke does not use this key.

Update your keyboard preferences as suggested below. These changes are
optional but will minimize keyboard shortcut conflicts.

6 | Chapter 2   Preparing Your Workstation

http://www.autodesk.com/smoke-systemrequirements


NOTE The keyboard preferences are set per Mac OS X user account. Make sure
you apply them to all the Mac OS X user accounts you plan to use with Smoke.

To edit OS keyboard shortcuts:

1 Open the System Preferences application.

2 Click Keyboard.

3 In the Keyboard tab, enable Use all F1, F2, etc. keys as standard function
keys.

NOTE This option is available only if you are using an Apple keyboard.

4 Click the Keyboard Shortcuts tab.

5 Select each section in the left panel, and then disable all its keyboard
shortcuts, or change the shortcuts to include the COMMAND key.
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Configuring Wacom Pen Buttons
To make sure the Wacom pen buttons work properly in Smoke, configure
them as follows.

1 Open the System Preferences > Wacom Tablet panel.

2 If Grip Pen does not appear in the Tool section, touch the pen on the
tablet.

3 Select the Pen tab.

4 Make sure the top pen button is assigned to the double-click function,
and that the bottom pen button is assigned to the right-click function.
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Installing and Licensing
Smoke

About Trial License Installation
A trial license of Smoke lasts for 30-days. The “Days Remaining” in your trial
appears in the Product License Activation window each time you start Smoke.

NOTE Do not use the Activate button from the Product License Activation window
to activate a network licensee. You must re-install Smoke to install and activate your
network license. See About Installing Smoke with the Network License (page 15).

Installing the Trial Version Smoke

To install the trial version Smoke:

1 Locate the Smoke installer. Do one of the following:
■ If you are installing Smoke from a DVD, insert the DVD, and then

double-click the DVD icon that appears on your desktop.

■ If you are installing Smoke from a downloaded .dmg disk image file,
double-click the file.

The contents of the DVD or .dmg  disk image are displayed.

2 Double-click Install Smoke 2012.

3 Click Continue in the first window of the installer.

3
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4 In the Important Licensing Information window, be sure to read all of
the information that appears in this window and then click Continue.

5 In the Product Information window, select “I want to try this product
for 30 days”.
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6 Depending on your OS configuration, the Select a Destination window
may appear.

Click “Install for all users of this computer”, and then click Continue.

7 In the Additional Content window, select Add Tutorial Content to install
sample material that you can use to explore Smoke.

8 Click Continue in the Application Help window. If you want to install
help locally, you can click the link to download the help installer.
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9 In the Media Storage window, click Select to define an internal or external
storage volume for your media.

A file browser window opens.
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10 Browse to the volume you want to use for media storage. The installer
will automatically create a subfolder called ManagedFolder7 under the
folder you select, so that all Smoke media files are kept in one place.

WARNING Never use your Mac OS X system disk for media storage, as this
may fill up the drive and impair system performance.

11 Type a name for your media storage folder in the Media Storage Name
field. This name will also be used by Smoke to refer to your media storage
folder.

NOTE This name can only contain non-accented latin letters and numbers.
Do not use special characters.

12 Click Continue.

13 Click Install to begin the installation process.

A success message appears when Smoke is installed.
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14 Restart your workstation.

15 Start Smoke. In the Product License Activation window, click Try.
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Converting from Trial to a Network License

You must re-install Smoke to install and configure a network license. Do not
click the Activate button to activate a Network License of Smoke.

See About Installing Smoke with the Network License (page 15).

About Installing Smoke with the Network
License

NOTE If you have a trial version of Smoke installed, you must re-install Smoke to
install and configure the network license. Do not use the Activate button from the
Product License Activation window to activate a network license of Smoke.

With a network license, you must install a license server to manage the license.
■ If you have only one Autodesk product running on a single workstation,

the license server can be installed and set up for you automatically on the
same workstation as Smoke. See Installing Smoke with a Local Network
License (page 15).

■ If you manage licenses from multiple Autodesk products or for many
workstations across your network, consider installing and configuring the
license server on a dedicated workstation before you install Smoke. See
Understanding License Server Models (page 71).

Installing Smoke with a Local Network
License

If you have a trial installed, you must reinstall Smoke to install and configure
a network license.

Follow this procedure to install the license server on the same machine as
Smoke.

To install Smoke with a local network license server:

1 Locate your serial number. The serial number is located on the outside
of the product packaging, or in the Autodesk® Upgrade and Licensing
Information email.
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NOTE If you have lost your serial number, contact the Autodesk Business
Center (ABC) at 800-538-6401 for assistance.

2 Locate the Smoke installer. Do one of the following:
■ If you are installing Smoke from a DVD, insert the DVD, and then

double-click the DVD icon that appears on your desktop.

■ If you are installing Smoke from a downloaded .dmg disk image file,
double-click the file.

The contents of the DVD or .dmg  disk image are displayed.

3 Double-click Install Smoke 2012.

4 Click Continue in the first window of the installer.

5 In the Important Licensing Information window, be sure to read all of
the information that appears in this window and then click Continue.
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6 Select “I have my product information” and enter your serial number.

7 In the License Type window, select Network License and click Continue.
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Network License Configuration window opens.

8 If you do not have your license file, you must register your
product to receive your license file and continue the
installation process.
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Click the “Click here” link.

A browser window opens. If the web page does not appear, close the
Browser and click again the "click here" link again.

You must create an Autodesk User ID, if you do not have one, and fill
in all of the required information, including your serial number, Server
host name and Server ID.

If you do not know the Server host name or Server ID of your machine:

■ Look in the installer. This information appears in the Network License
Configuration window if you have Use Local Machine selected.

■ If you have advanced to another screen, you can get this information
in the About This Mac window. See Get Your License Server Hostname
and Server ID Manually (page 25).

NOTE Remove the colons “:” from the Mac address when you register your
product on the Autodesk website.

You license appears in your browser window. Keep the window
open while you continue the installation process. You can save
this file anywhere on your machine with any name.
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Continue with the installation.

9 In the Network License Configuration window, select the following:
■ Single license server

■ Use local machine

NOTE Make sure Use local machine is selected.

10 Copy and paste your license information into the License File window.
Be sure not to overwrite any previous license entries.
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11 Depending on your OS configuration, the Select a Destination window
may appear.

Click “Install for all users of this computer”, and then click Continue.

12 In the Additional Content window, select Add Tutorial Content to install
sample material that you can use to explore Smoke.
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13 Click Continue in the Application Help window. If you want to install
help locally, you can click the link to download the help installer.

14 In the Media Storage window, click Select to define an internal or external
storage volume for your media.
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A file browser window opens.

15 Browse to the volume you want to use for media storage. The installer
will automatically create a subfolder called ManagedFolder7 under the
folder you select, so that all Smoke media files are kept in one place.

WARNING Never use your Mac OS X system disk for media storage, as this
may fill up the drive and impair system performance.

16 Type a name for your media storage folder in the Media Storage Name
field. This name will also be used by Smoke to refer to your media storage
folder.

NOTE This name can only contain non-accented latin letters and numbers.
Do not use special characters.

17 Click Continue.

18 Click Install to begin the installation process.
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A success message appears when Smoke is installed.

19 Restart your workstation.

Smoke is installed and ready to run.

If Smoke does not start, see Troubleshooting License Errors (page 51).
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Get Your License Server Hostname and Server
ID Manually

You must provide your license server hostname and server ID during the
installation process.

In most cases, you will install the license server on the same machine as Smoke.
You may consider installing the license server on another machine if you have
multiple Autodesk products to manage.

To get your license server hostname and server ID:

1 Open About this Mac.

a. License Server Hostname b. License Server ID

2 Click More Info.

3 The Server hostname appears on the top left corner of the window and
the Server ID is the Hardware MAC address.

NOTE Remove the colons “:” from the Mac address when you register your product
on the Autodesk website.
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About Standalone License Installation
A standalone license does not require a license file or a license server.

When you register your standalone license, you receive a serial number which
is required during the installation and activation process. See Installing and
Activating a Standalone License (page 26).

Installing and Activating a Standalone
License

■ If you have a Trial installed, start Smoke, click Activate and follow the
instructions on the website. You must have your serial number.

■ If Smoke is not installed, use the following instructions.

To installing Smoke with a standalone license:

1 Locate your serial number. The serial number is located on the outside
of the product packaging, or in the Autodesk® Upgrade and Licensing
Information email.

NOTE If you have lost your serial number, contact the Autodesk Business
Center (ABC) at 800-538-6401 for assistance.

2 Locate the Smoke installer. Do one of the following:
■ If you are installing Smoke from a DVD, insert the DVD, and then

double-click the DVD icon that appears on your desktop.

■ If you are installing Smoke from a downloaded .dmg disk image file,
double-click the file.

The contents of the DVD or .dmg  disk image are displayed.

3 Double-click Install Smoke 2012.

The installer starts.

4 Click Continue in the first window of the installer.
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5 In the Important Licensing Information window, be sure to read all of
the information that appears in this window and then click Continue.

6 Select “I have my product information” and enter your serial number.
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7 In the License Type window, select “Standalone license”.

8 Depending on your OS configuration, the Select a Destination window
may appear.
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Click “Install for all users of this computer”, and then click Continue.

9 In the Additional Content window, select Add Tutorial Content to install
sample material that you can use to explore Smoke.

10 Click Continue in the Application Help window. If you want to install
help locally, you can click the link to download the help installer.
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11 In the Media Storage window, click Select to define an internal or external
storage volume for your media.

A file browser window opens.
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12 Browse to the volume you want to use for media storage. The installer
will automatically create a subfolder called ManagedFolder7 under the
folder you select, so that all Smoke media files are kept in one place.

WARNING Never use your Mac OS X system disk for media storage, as this
may fill up the drive and impair system performance.

13 Type a name for your media storage folder in the Media Storage Name
field. This name will also be used by Smoke to refer to your media storage
folder.

NOTE This name can only contain non-accented latin letters and numbers.
Do not use special characters.

14 Click Continue.

15 Click Install to begin the installation process.

A success message appears when Smoke is installed.
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16 Restart your workstation.

17 Start Smoke.

18 In the Product License Activation window, click Activate.

19 Enter your serial number and follow the steps to register and activate
your product online. If you do not have an internet connection, see
Offline Registration and Activation (page 32).

Offline Registration and Activation
If for some reason online registration and activation is not possible, you can
still register and activate your product offline. Contact Autodesk by mail, fax,
or phone. Your activation code is sent back to you by mail or fax.
E-mail Create an e-mail message with your registration information and send
it to Autodesk.

Fax Enter your registration information, and fax the information to Autodesk.

Phone Provide your registration information to one of our representatives
over the phone.
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Use the numbers or e-mail address that correspond to your area:

Fax and Phone Numberse-mailArea

FAX:authcodes@autodesk.comUnited States,
Canada 800.225.6490 or
Latin America 415.507.4937

Phone:
800.551.1490

Fax:authcodes.neu@autodesk.comEurope
Middle East +41 (32) 7239169
Africa

Fax: +65.6735.4857ap.register@autodesk.comAsia Pacific

Offline registration and activation is necessary under the following conditions:
■ An online request has timed out

■ A processing error occurred such as an invalid serial number

Uninstalling Smoke
Perform the following procedure to uninstall Autodesk Smoke from your Mac.

To uninstall Smoke from your Mac:

1 If Smoke is running, exit it.

2 In Finder, go to the Applications / Autodesk / Smoke 2012 folder.

3 Run the Smoke 2012 Uninstaller application, and follow the on-screen
instructions to uninstall Smoke.

4 (Optional, for advanced users) Perform the following steps to completely
remove all the files installed by Smoke on your system drive:
■ Open Finder, and click COMMAND+SHIFT+G.

■ In the dialog box that opens, enter /usr/discreet.

The contents of the /usr/discreet folder are displayed.
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■ If you have no other versions of Smoke installed on your Mac, delete
all the subfolders under the discreet folder, with the exception of the
clip, project and user folders. These folders contain the data files of the
projects and clips you created in Smoke, and might be useful next
time you install Smoke.

■ If you have several versions of Smoke on your Mac, and you want to
remove just one of them, delete only the Smoke subfolder
corresponding to the version you uninstalled.

Other Software
The following components are installed by default with Smoke:
■ Autodesk Backburner Manager

■ Autodesk Backburner Server

■ Autodesk WiretapCentral

■ Autodesk Wiretap Gateway

■ Autodesk Backburner Media I / O Adapter

■ License Server
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Installing and Licensing Wiretap Gateway

Wiretap Gateway reads image media in a number of formats from any storage
device, and streams it live as raw RGB to local or remote clients. When you
import files using a Gateway Library from the Clip Library in Smoke, it is
Wiretap Gateway that gives you access to those files.

By default, Wiretap Gateway is installed with Smoke and there is nothing
more you have to do to make it work for your local installation of Smoke.

If you have a network license of Smoke, you can install up to two remote
Wiretap Gateway servers to provide transcoding services to a number of other
workstations throughout your network.

You must license remote Wiretap Gateway servers.

For instructions on installing and licensing Wiretap Gateway on remote
workstations, see the Autodesk Wiretap Central and Autodesk Wiretap Gateway
Installation Guide.

Installing and Licensing Autodesk Burn

Autodesk Burn is a Linux-based network processing solution. Burn allows you
to render images in the background using low-cost systems and frees your
workstation for more creative tasks.

Your distribution of Smoke comes with a distribution of Burn, which you can
deploy on a Linux workstation on your network.

For information on installing and licensing Burn, see the Autodesk Burn
Installation and User Guide.

Other Software | 35



36



Configuring Smoke

About Smoke Setup
The Smoke Setup utility allows you to easily configure general Smoke settings,
add or edit the media storage, configure background rendering, and configure
licensing.

Run the Smoke Setup utility from the Applications / Autodesk / Smoke 2012 /
Utilities folder.

Configuring General Settings
The General tab of the Smoke Setup utility enables you to configure the following
application settings.

4

37



Video Device Use this setting to specify the video output device to be used
with Smoke. If your Mac is equipped with an AJA Kona 3 card, select KONA
3.

Audio Device Use this setting to specify the audio output device to be used
with Smoke. If your Mac is equipped with an AJA Kona 3 card, select AJA.
Otherwise, select CoreAudio to use the default sound card of your workstation.

NOTE You can only use the AJA card as an audio device if you also set the AJA
card as the video device. Similarly, you can only use CoreAudio if the AJA card is
not set as the video device.

Reserved Application Memory Use this field to specify the amount of memory
allocated for Smoke frame buffers. In most cases, you should leave this setting
to Automatic. The default configuration is sufficient for most projects, regardless
of the different resolutions you may be working with.

Max Library Size Use this setting to define the maximum size of any single
clip library, in megabytes. The higher the value, the more memory the
application uses. Using a larger value reduces memory fragmentation, which
optimizes memory use.
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NOTE To run Smoke, you must have at least 10 megabytes of free hard drive
space in addition to the value set by this field.

Network Panel Display Use this setting to filter the list of remote media
storage volumes that are displayed in the Network panel. Select ShowMounted
to see only media storage volumes that are mounted and available on the
Wire network, or ShowAll to show all media storage volumes available on the
network without checking whether they are mounted.

NOTE Using ShowAll slightly reduces the time needed for your application to start,
as no checks are performed on remote media storage volumes.

Default Web Browser  Use this setting to specify the Web browser used by
Smoke to browse the Help and view HTML tables of contents for archives. Set
this option to open to use the default Web browser.

Cleaner Export Destination Path If you are using Autodesk® Cleaner® XL
digital video mastering and encoding software, use this field to define the
default path on a Microsoft® Windows® workstation where clips are saved
after encoding by Cleaner XL. The default path you enter appears in the
Cleaner Destination Path field when you select Cleaner in the Format Box of
the Image Export menu. You can edit the path there. If there is an ftp path
in the output profile, the ftp path is used as an additional destination for
encoded jobs. See your application help.

Archive Size Use this field to define the maximum size for a file archive in
MB. The default value is 1024MB.

Default Location Use this field to define the default location for archives
created in Smoke. The default location is /var/tmp/archive.

Table of Contents Location Use this field to define the location where online
HTML and ASCII tables of contents are saved when archiving. The default
location is /usr/discreet/archive.

NOTE If you prefer to edit these parameters directly in the application configuration
file, click Manual Edit. Be very careful when working with the configuration file.
Incorrect settings may make your application unusable.

When you have finished configuring these settings, click Apply to save them.
If you want to revert to the last saved configuration, click Reload. Note that
this will undo unsaved changes in all the tabs of the Smoke Setup utility.
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Defining the Video Preview Device
Use the Preview tab of the Smoke Setup utility to specify the device used for
the graphics-to-video display.

Enable entries for the resolutions of the projects on which you will be working,
as well as the resolutions supported by your hardware configuration.

If necessary, you can also add new entries, and duplicate or delete existing
entries.

When you have finished configuring these settings, click Apply to save them.
If you want to revert to the last saved configuration, click Reload. Note that
this will undo unsaved changes in all the tabs of the Smoke Setup utility.

Defining VTRs
Use the Vtr tab of the Smoke Setup utility to specify the video tape recorders
you want to use for clip I/O.
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You can enable VTRs of different video formats. Any enabled VTR can be
selected for a project, regardless of the project's video I/O timings.

If necessary, you can also add new entries, and duplicate or delete existing
entries.

When you have finished configuring these settings, click Apply to save them.
If you want to revert to the last saved configuration, click Reload. Note that
this will undo unsaved changes in all the tabs of the Smoke Setup utility.

Configuring VTR Emulation
Use the Emulator tab of the Smoke Setup utility if you want to configure your
workstation to emulate a Sony™ VTR.

You can specify more than one emulator. Any enabled emulator can be selected
for a project, regardless of the project's video I/O timings.

If necessary, you can also add new entries, and duplicate or delete existing
entries.
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When you have finished configuring these settings, click Apply to save them.
If you want to revert to the last saved configuration, click Reload. Note that
this will undo unsaved changes in all the tabs of the Smoke Setup utility.

Adding or Editing Media Storage Volumes
Use the Media Storage tab of the Smoke Setup utility to define new media
storage volumes for use with Smoke, or to edit the settings of existing media
storage volumes.
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To define a new media storage volume, click Add.

A new entry is created in the media storage list, and is populated with default
values.

NOTE For safety reasons, the Name and Location fields are blank by default. You
are required to fill in these fields before you can click Apply.

To edit the settings of a media storage folder:

1 Double-click the Name field and enter a meaningful label for the media
storage. For example, MyMedia.

This label identifies the media storage in Smoke.

2 Double-click the Location field, and browse to the directory that will
contain the Smoke media files on your storage device. For example, /
Volumes/G-SPEED/ManagedFolder7.

WARNING Do not select the root of a drive as your media storage folder.
Create a subfolder to hold all your media files in one place. We recommend
that you name the subfolder ManagedFolder<x>, where <x> is the number
that appears in the Id column in the Smoke Setup utility.
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3 (Optional) Double-click the 8-bit Integer, 10-bit Integer, 12-bit Integer
and 12-bit Packed Integer fields, and choose the file formats that Smoke
will use when writing frames of those bit depths to the storage.

4 (Optional) If you plan to use the JPG file format, double-click the Jpeg
Compression field, and set JPEG compression to a value between 0 (lowest
compression, highest quality) and 100 (highest compression, lowest
quality).

5 Click Apply to save your configuration.

If you want to revert to the last saved configuration, click Reload. Note
that this will also undo any unsaved changes in the other tabs of the
Smoke Setup application.

NOTE If you prefer to edit these parameters directly in the storage configuration
file, click Manual Edit. Be very careful when working with the configuration file.
Incorrect settings may make your application unusable.

Configuring Backburner Settings

If you want to use an Autodesk® Burn® background processing network, or
to use your Mac as a background processing node, define Backburner settings
in the Backburner tab of the Smoke Setup utility.

To configure background processing for Smoke, use the four fields in the
Application Settings Section.

To use your Mac as a background processing node, define the hostname of
the Backburner Manager that will distribute processing jobs to your Mac, in
the Local Server Settings section.
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To configure settings for jobs submitted by Smoke to a Backburner network:

1 In the Manager Hostname field of the Application Settings section, enter
the hostname or IP address of the Backburner Manager system that will
handle background jobs submitted by Smoke.

Setting the Manager Hostname enables the Background Wire® and
Background Proxies buttons in the application; they are otherwise greyed
out.

2 In the Job Priority field, enter the priority for jobs sent by Smoke to the
Backburner Manager on your rendering network. Job priority can range
from 0 to 100, where 0 is the highest priority and 100 is the lowest. The
default is 50.

3 In the Server Group field, enter the name of the group of render nodes
to which jobs created in Smoke will be submitted. Refer to the latest
Autodesk Backburner User Guide for information on creating groups in
Backburner Monitor.

4 From the Group Capability drop-down list, select whether the nodes in
your group are equipped with GPU-accelerated graphics cards or not.
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Set this value as follows:

■ If none of the nodes in your rendering network are equipped with
GPUs, select software. Smoke will not send jobs that require a GPU
to the rendering network, but only jobs that can be rendered in
software mode by the render nodes.

■ If ALL the nodes in your rendering network are equipped with GPUs,
select gpu. Smoke will send all jobs to the GPU-equipped nodes, even
if some jobs do not specifically require a GPU render node.

NOTE If your rendering network also contains render nodes without a
GPU, but this value is incorrectly set to gpu, all jobs are sent only to
GPU-equipped render nodes, and the nodes without a GPU are never
used.

■ If your rendering network contains a mix of nodes with GPUs and
without GPUs, select hybrid. The application sends all jobs to the
rendering network, and Backburner Manager distributes each job to
the appropriate type of render node.

NOTE Select gpu or hybrid only if you are sure that at least one node in
your rendering network is equipped with a GPU. Attempting to submit
a job that requires a GPU to a rendering network with no GPU-equipped
render node results in the job being stuck in the rendering queue
indefinitely.

Configuring the License Server
You can use the Licensing tab to configure the location of your license server.
■ To set the current workstation as your license server, click Add Localhost

and click Apply.

The license server must be installed on the local workstation. See Installing
Smoke with a Local Network License (page 15).

■ To identify another workstation as the license server, click +, enter the
name in the hostname field, and then click Apply.

The license server must be installed on the remote workstation. See Install
the Network License Manager (page 88).
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About Compatibility with Projects Created in
Previous Versions of Smoke

Projects and clip libraries created in previous versions of Smoke are read-only.
■ If the original project is on the same system, create a project in 2012 and

then copy the clip libraries from the old project to the new project.

If you have many projects to upgrade, use the project upgrade script to
create the 2012 projects for you. See Upgrading Smoke Projects to the
Current Version (page 48).

■ If the original project is on another system that has a previous version
installed, transfer (push) the clip libraries to a project on the 2012 system.
See Transferring Clip Libraries from a Previous Project on a Remote Host
to a 2012 Project (page 49)

■ Alternatively, you can archive the project from an older version and restore
the archive in the latest version. See the application help for instructions
on creating and restoring archives.
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NOTE Projects and clip libraries of a service pack for the same version are
compatible.

Upgrading Smoke Projects to the Current
Version

NOTE You do not need to perform this task if you are upgrading to a service pack
of the same version.

Use the copyProjects command-line tool to recreate Smoke projects from
previous versions in the latest version.

Using this tool instead of manually re-creating your projects is the
recommended approach, as it reduces the time needed to migrate multiple
projects, and prevents human error.

NOTE The copyProjects tool does not copy any media. It only re-creates projects
and copies their settings and setups to the current version. You still have to transfer
your media using the network library.

To copy projects using the copyProjects tool:

1 Open a the Terminal (/Applications/Utilities) and log in as root.

2 Go to the location of the copyProjects script. Type:

cd /usr/discreet/<smoke_version>/bin

3 Launch the script. Type:

./copyProjects

The tool detects all projects from previous versions, and returns the
following message:

Projects will be copied to version 2012

Do you wish to continue?

NOTE You can also run the copyProjects command with the -s parameter
to change the suffix that the script adds to the new copies of projects. For
example: /usr/discreet/<product_home>/bin/copyProjects -s _2011ext1

4 If the version returned by the script is the newly installed version, answer
Yes and continue this procedure. Otherwise, perform the steps in the
following procedure to change the application version to which projects
are copied.
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5 Confirm each project you want to copy to the new version, or type “a”
to copy all projects.

If you don't use the -s parameter, the default suffix _copy is appended
to the names of the copied projects (e.g. myProject will be copied as
myProject_copy)

6 Use the network library to transfer media into the copied projects.

To change the application version projects are copied to:

1 Open a terminal and log in as root.

2 Stop Stone and Wire by typing:

/usr/discreet/sw/sw_stop all

3 Unlink the Wiretap startup script by typing:

unlink
/usr/discreet/sw/sw_depend/ifffsWiretapServer.sw_depend

4 Link the Wiretap startup script to the latest version by typing:

ln -s
/usr/discreet/wiretap/<version>/ifffsWiretapServer.sw_depend
/usr/discreet/sw/sw_depend/ifffsWiretapServer.sw_depend

5 Start Stone and Wire by typing:

/usr/discreet/sw/sw_start all

6 Run the copyProjects script again.

Transferring Clip Libraries from a Previous
Project on a Remote Host to a 2012 Project

To access clip libraries from projects created with Smoke versions 2010 or 2011
on a remote host with 2012, you must transfer the clip libraries to a project
created in version 2012.

You can install version 2012 on the remote system and use Wire to transfer
the clip libraries to a version 2012 project. See your application help.

If you do not want to or cannot install Smoke 2012 on the remote system,
use the following procedure to transfer clip libraries between two versions.
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To transfer clip libraries to a 2012 project:

1 Use Smoke 2010 or 2011 to create a project and a clip library on the 2012
system. See your application help. The project and library is formatted
for the software version it was created with.

2 Use the 2010 or 2011 application to move clips over the network into
the previously created project on the 2012 system. You can use
Background Wire to help free up the resources of the workstation running
the older version of the application. See your application help.

3 Create a new project on the version 2012 system. If you have many
projects, use the copyProjects script.

4 Use the 2012 application to open the library created in step 1 (the library
is read-only).

5 Use Dual View to drag the clips into the 2012 project and library.

6 Use the older application version to remove the project created in step
1. 2012 applications cannot remove projects created with previous
versions because they are read-only.

TIP If you have 2010 or 2011 installed on your 2012 system, you can access the
2010 or 2011 system remotely to transfer the media using Wire without
interrupting a session on that station. See your application help.
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Troubleshooting
Smoke Installation,
Licensing and
Configuration

Invalid Serial Number Error
If you click the Activate button and enter a network license serial number, you
will get an “Invalid serial number” error.

To go from a trial to commercial or educational license of Smoke, you must
re-install Smoke to install and configure the network license server.

See About Installing Smoke with the Network License (page 15).

Troubleshooting License Errors
Follow these procedures if you are unable to start Smoke due to license errors.

To troubleshoot license errors:

1 Check that Smoke is using the right license server. See Verifying the License
Server (page 52).

2 If you are using DHCP (Dynamic Hostname Configuration Protocol), the
name of the license server might change and cause license errors. See Li-
censing Errors Caused by DHCP Problems (page 53).

3 If Smoke does not start and you are still getting license errors, restart the
license server using the License Server Configurator. See Stop and Restart
the License Server (page 90).
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4 If Smoke does not start and you are still getting license errors, check the
license and then restart the license server. See Verifying the License File
(page 54).

Verifying the License Server

If you are getting license errors when starting Smoke, you should first check
that Smoke is pointing to the right license server.

In most cases, the license server is installed on the same workstation as Smoke.

To verify the license server:

1 Start Smoke Setup. Smoke Setup can be found in the Applications/ Smoke
2011/Utilities folder.

2 Open the Licensing tab.

3 Click the - button to remove a license server from the list.
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4 Do one of the following:
■ Click Add localhost to use the current workstation as the license

server.

■ Click + and then type the hostname of the license server in the
Hostname field.

5 Click Apply to confirm any changes.

You must restart Smoke to confirm if it starts with the new license server.

If Smoke does not start, try re-starting the license server. See Stop and
Restart the License Server (page 90).

Licensing Errors Caused by DHCP Problems

Smoke does not start if the machine cannot resolve its own hostname. This
can be caused by DHCP hostname change, a missing DNS suffix, or a missing
.local hostname suffix in the license file.

To fix licensing errors caused by DHCP problems:

1 Open the License Server Selector from Applications/Autodesk/Smoke
Common Utilities.

2 Select the License Server currently in the list, and then click the "-"
(minus) button to remove it.

3 Click Add Localhost. The License server hostname should be “127.0.0.1”.
Click Ok.

4 Open the License Server Configurator from Applications/Autodesk/Smoke
Common Utilities.

5 Click the Licensing tab. Change the server name in the license for
“localhost” (i.e: SERVER server_name 002500ef9055 to SERVER localhost
002500ef9055).

6 Click Apply.

7 Click the Server Status tab, and click Restart to restart the server.Re-start
Smoke.
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Verifying the License File

If you are having problems with the license server, verify that the license server
is using the Smoke license.

To verify the license file:

1 Open the License Server Configurator. You can find the License Server
Configurator in one of the following places:
■ If Smoke is installed on the same workstation: Applications/ Smoke

/Utilities

■ If Smoke is not installed on the workstation:
/Applications/Autodesk/Adlm

2 Click the Licenses tab.
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3 Cut and paste the license into the Licenses window or open the license
file that you saved locally.

4 Click Apply and then restart the license server.

Enabling Remote Login
To ensure you will be able to reboot your workstation if it freezes, it is
recommended that you enable remote login on your Mac.

To enable remote login:

1 Open System Preferences, and click Sharing.

2 Enable Remote Login. Allow access to all users by selecting “All users”.

3 Close System Preferences.
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Viewing Application Error Messages
If you experience problems with Smoke or any of its related components,
checking the error messages in the Mac OS X system console might help you
to identify the issue.

To view Smoke error messages:

1 Open the Console application from the Applications / Utilities folder.

2 From the File menu, click New Database Search.

3 Give your search a meaningful name. You will be able to reuse it later.

4 Define the search criteria as illustrated in the previous screenshot, and
click OK.

A new Console window opens and displays all messages sent by Autodesk
applications or services, and containing the words “error”, “failed” or
“failure”. The search settings are saved in the left panel of the Console
window, under Database Searches.

5 Look through the error messages to find any information that might
help you identify the problem. If you encounter error messages about
Backburner or Stone and Wire, refer to the following section for
information on restarting these services.
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Checking that Background Services are
Running

To check that all necessary background services are running, open the Service
Monitor application from the Applications / Autodesk / Smoke Common Utilities
folder.

A green status light means that a service is running. A red light means that
the service is not running. Click Restart to activate it.

WARNING Before stopping or restarting a background service, make sure Smoke
is not running, and that there are no network connections to your media storage.

Forcing Smoke to Exit
If Smoke crashes but does not close, use the following procedures to force it
to quit.

1 Run the Service Monitor application from the Applications / Autodesk /
Smoke Common Utilities folder.

2 Click the Troubleshooting tab.
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3 Click NOW! to force Smoke to quit.

4 If Smoke still does not quit, use the following procedure to exit Smoke
from the Terminal.

To exit Smoke from the Terminal:

1 Open the Terminal from the Applications / Utilities folder.

2 Type: sudo killall -9 smoke

3 Press Enter.

4 Enter your password and press Enter.

Handling System Freezes
If your workstation “freezes” for any reason, DO NOT force it to power off
using the Power button, as this may cause problems with your media storage.

To avoid any problems, always use the following procedure to safely restart
your workstation when it freezes.

To reboot your Mac OS X workstation:

1 On a Linux® system or another Mac on your network, open a terminal
and type the following command to connect remotely to the Smoke Mac
OS X workstation:

ssh <user_name>@<Mac_IP_Address>

Where <user_name> is a user that exists on the Smoke Mac OS X
workstation, or a NIS (network) user, and <Mac_IP_Address> is the IP
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address of the Smoke Mac OS X workstation. You can also use the
workstation hostname instead of the IP address.

NOTE You can also connect from a Windows® system, by installing a SSH
client such as OpenSSH.

2 Enter your password when prompted.

3 When you are logged into the Mac OS X workstation, type the following
command to reboot it:

sudo reboot

4 Enter your password when prompted.

The workstation reboots.

Repairing Media Storage Mount Points
If you force your workstation to power off, the operating system may mount
the storage on an incorrect mount point folder when it restarts (for example,
/Volumes/Storage1 instead of /Volumes/Storage). This issue prevents Smoke from
being able to access the media storage.

To avoid this problem, NEVER use the Power button to force a shutdown if
your workstation freezes. Use the procedure described in the previous section
to safely reboot your workstation.

If you did force the workstation to power off, and are now experiencing storage
issues, perform the following procedure to delete the incorrect mount point,
and to mount your storage to the proper mount point.

To delete an incorrect mount point:

1 Log into your workstation as a user with administrative privileges.

2 Open System Preferences, click Sharing, and disable all the file services.

3 Open Finder.

4 Press COMMAND+Shift+G, and type /Volumes in the text field.

5 In the /Volumes folder, locate the incorrect mount point folder. It should
have the name of the original mount point (for example, Storage), but
its icon depicts a folder instead of a disk drive.

6 Right-click the incorrect mount point folder, and select “Move to Trash”
from the context menu. Enter your password if prompted.

The folder is deleted.
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7 Restart your workstation.

The media storage should mount to the proper location (for example,
/Volumes/Storage) after the reboot.

NOTE If the media storage is still not available after restart, open Disk Utility from
the Applications / Utilities folder, select your media storage disk, and click Repair
Disk in the First Aid tab. See the Mac OS X documentation for details.

Fixing VOLUMEMGT and No Volume Errors
Follow the steps below if you ever start Smoke and cannot select your
framestore volume, or if you get the following error:

Error: VOLUMEMGT : Failed to initialize Stone+Wire connection.

To solve the errors listed above:

1 Exit Smoke.

2 Open the Service Monitor application from the Applications / Autodesk /
Smoke Common Utilities folder.

3 Restart the Stone+Wire service.

4 Start Smoke.

Rebooting after an IP Address or Host Name
Change

If your workstation uses DHCP to obtain its network configuration, it is
advisable to restart it after a change of IP address, for instance, when switching
from a wired to a wireless connection.

Furthermore, ensure that your workstation’s hostname remains constant and
is resolvable at all times in the DHCP environment, as the media storage and
networking components of Smoke (known as “Stone and Wire”) do not support
dynamic hostname changes.
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Sending Application Logs to Autodesk
Customer Support

If you have contacted Autodesk Customer Support to troubleshoot an issue
with your application, you may be asked to submit the application log files.

To submit Smoke log files to Autodesk:

1 Make sure your Mac is connected to the Internet.

2 Run the Service Monitor application from the Applications / Autodesk /
Smoke Common Utilities folder.

3 Click the Troubleshooting tab.

4 Click Send.

Smoke and system log files are automatically sent to Autodesk.

Switching Your Mac OS X Kernel between
32-bit Mode and 64-bit Mode

Smoke 2012 for Mac OS X is a 64-bit application that can run on either the
32-bit Mac OS X kernel or the 64-bit kernel, while Smoke 2010 for Mac OS X
specifically required the 64-bit kernel.

If you are running Smoke 2012 for Mac OS X on a workstation where Smoke
2010 for Mac OS X was previously installed, you may need to switch the Mac
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OS X kernel into 32-bit mode for certain third-party drivers and software to
work properly.

Skip this section if you are running Smoke 2012 for Mac OS X on a workstation
where Smoke 2010 for Mac OS X was never installed. By default, Mac OS X
comes with the 32-bit kernel activated, which can run most 64-bit applications,
including Smoke 2012.

To switch the kernel between 32-bit mode and 64-bit mode:

1 Run the Service Monitor application from the Applications / Autodesk /
Smoke Common Utilities folder.

2 Click the Troubleshooting tab.

3 Click the 32 bit or 64-bit button.

4 Reboot your Mac for the change to take effect.
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Licensing

Introduction

License Types and Behaviors

Autodesk provides two main types of licenses:
■ A stand-alone license supports one or more Autodesk products for an

individual user. Similarly, a multi-seat stand-alone license supports a specific
number of users. While the software can be installed on additional computers
in your facility, the licensed number of users cannot be exceeded.

■ A network licensesupports a specific maximum number of users who are
connected to a network. A software utility known as the Network License
Manager (NLM) issues licenses to users, up to the number of licenses
purchased. At this point, no more computers can run the Autodesk product
until a license is returned to the NLM.

License usage types

NOTE All license types are available as stand-alone and network except for the
Student Portfolio license, which is available as stand-alone only.

Commercial A license for a product that was purchased commercially.

Not for Resale A license for a product that is not sold commercially.

Educational (EDU)/Institution A license designed specifically for educational
institutions.

Student Portfolio A license for students who are using an Autodesk product as
part of their curriculum.
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License behaviors

Trial A license that allows individuals to run a product or suite in trial mode
for a specified time period, usually 30 days. The trial period starts the first
time you launch the product, or one of the products in the suite. You can
activate and register the license at any time, before or after the trial period
expires.

Permanent Allows permanent use of an Autodesk product.

Term Extendable Allows access to an Autodesk product for a limited time.
The term can be extended at any time.

Term Non-Extendable Allows access to an Autodesk product for a limited
time. The term cannot be extended.

Activation

NOTE Do not use the Activate button to activate a network license. You must
un-install and re-install Smoke to activate a network license.

When you activate your product, you receive an activation code. If you activate
through an Internet connection, your activation code is automatically retrieved
from Autodesk and the product starts. If you do not have an active Internet
connection, some products provide instructions for offline registration.
Otherwise, you need to connect to the Internet to activate the product.

If you upgrade your product from an earlier version, you may need to provide
your old serial number. For more information on activation, go to Autodesk
Licensing and select the FAQ link.

NOTE If you are installing and using an Autodesk product on both operating
systems of a dual-boot operating system, you must obtain a separate activation
code for each operating system.

Registration

Depending on your product, registration is optional or required. If required,
you are prompted to create an Autodesk User ID associated with an individual
or company account. If registration is optional, you can choose to postpone
it, and you will be reminded periodically to register. The Autodesk website
where you register products is https://registeronce.autodesk.com.

64 | Chapter 6   Licensing

http://www.autodesk.com/licensing
http://www.autodesk.com/licensing
HTTPS://REGISTERONCE.AUTODESK.COM/


Stand-Alone Licensing

Introduction to Stand-Alone Licenses

A stand-alone license authorizes a single user to use the specified Autodesk
product. The product can be installed on more than one computer, but
multiple instances of the same product cannot be running concurrently on
different computers.

Stand-alone licensing allows you to use your Autodesk product in trial mode
for a specified period, usually 30 days, from the first time you start the product.
For a product suite, the trial period countdown begins when the first product
is started, and it applies to all Autodesk products in the suite. You can activate
your license at any time before or after the trial period expires.

The licensing process creates a license file and a minor change to the
computer's file system. These changes remain on your computer when you
uninstall your product. If you reinstall your Autodesk product on the same
computer, the license remains valid. You do not have to reactivate the product.

Manage Your Stand-Alone License

View Product License Information

You can view detailed information about your Autodesk product license, such
as the license usage type and the license behavior.

To view product license information

1 Start your Autodesk product.

2 Click Help ➤ About, or About [Product Name].

3 In the About window, click Product License Information.
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Save License Information as a Text File

You can view detailed information about your Autodesk product and your
product license (such as the license usage type and the license behavior), and
then save this information as a text file for future reference.

To save license information as a text file

1 Start your Autodesk product.

2 Click Help ➤ About or About [Product Name].

3 In the About window, click Product License Information.

4 In the Product License Information dialog box, click Save As.

5 In the Save As dialog box, name the file, choose a location where you
want to save the file, and then click Save.

6 In the Product License Information dialog box, click Close.

Update Your Serial Number

You typically update your serial number for a stand-alone license when you
purchase a new license in order to change the license type or behavior. For
example, you would do this if you want to convert an educational license to
a commercial license, or if you want to extend the term of a term extendable
license. When you update a license, you do not need to uninstall and reinstall
the product. The new license includes a new serial number that you enter into
the Product License Information field.

Your serial number is located on the outside of the product packaging or in
the Autodesk Upgrade and Licensing Information email you received when you
downloaded your product.

When you register and activate your product, your serial number is submitted
to Autodesk over the Internet, if a connection is available.

If you have a suite of products that use a single serial number, only the first
product you register and activate displays the updated serial number. For other
products to display the serial number, you must update them from the Help
menu.

To update your serial number

1 Start your Autodesk product.
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2 Click Help ➤ About, or About [Product Name].

3 In the About window, click Product License Information.

4 In the Product License Information dialog box, click Update.

5 In the Update the Serial Number dialog box, enter your product serial
number.

NOTE If you have lost your serial number, go to www.autodesk.com/contactus
for assistance.

6 Click OK. The updated serial number is displayed.

NOTE In some cases, you must restart the product to display the updated
serial number.

7 In the Product License Information dialog box, click Close.

Transfer Your Stand-Alone License

About the License Transfer Utility

The License Transfer Utility is used only with stand-alone licenses. It transfers
a product license online from one computer to another, and ensures that the
product works only on the computer that contains the license.

IMPORTANT To transfer a license, the Autodesk product must be installed on
both computers. In addition, you need an Internet connection, and an Autodesk
user ID and password, available from the Autodesk Register Once website(https://re-
gisteronce.autodesk.com).

The License Transfer Utility is a custom stand-alone installation option. During
installation, a shortcut is created. A shortcut is installed once per product, per
computer.

You can transfer a license to another computer temporarily or permanently.
For example, a temporary transfer enables you to use the Autodesk product
on a mobile computer while your main computer is being repaired or replaced.

License transfers rely on the product serial number. Before an Autodesk license
can be exported, it must be activated with the serial number and product key.
During license import, a previously activated and exported license is imported
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to a product or suite installed with the same serial number. The activation is
transferred to the importing computer, completing the license transfer.

The number of concurrent license exports allowed is equal to the number of
seats you own. For example, if you own five seats you can have one export in
progress at a time.

When you upgrade your Autodesk product, you can no longer perform online
license transfers of the previous license.

Although the License Transfer Utility allows you to transfer your product
license between computers, your license agreement may not allow the
installation of an Autodesk product on more than one computer. Read your
license agreement to find out whether your product license permits the use
of the License Transfer Utility.

Export a License

A license is exported when the License Transfer Utility moves a product license
from a computer to the online Autodesk server.

The license can be exported as public or private:
■ Public means that anyone using the same serial number and their own

user ID and password can import that license.

■ Private means that you are reserving that license for yourself and the
license can only be imported with the same serial number, user ID, and
password that were used when it was exported.

If it has not been imported, a private license becomes public after 14 days.

To export a license

1 On the computer where you want to export the license, start the License
Transfer Utility.

The License Trasfer Utility (LTU) is located in: Applications | Autodesk |
Smoke | Utilities.

The Export the License dialog box displays the Autodesk product name
and serial number.

2 Click Sign In.

3 On the Log In page, enter your Autodesk user ID and password and click
Log In.

4 On the License Export page, confirm the export information.
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5 If you want to make the license available as a public import, click Make
the license available as a public import.

6 Click Export.

7 On the License Export Confirmation page, click Finish.

Import a License

A license is imported when the License Transfer Utility moves a previously
exported product license from the online Autodesk server to a computer. The
import action completes the license transfer process, and transfers the product
activation to the importing computer. The presence of an active license allows
your Autodesk product to run on that computer.

To import a license

1 On the computer where you want to import the license, start the License
Transfer Utility.

The License Trasfer Utility (LTU) is located in: Applications | Autodesk |
Smoke | Utilities.

The Import the License dialog box displays the Autodesk product name
and serial number.

NOTE If you are importing a license to replace a trial license, you will see
the Update the Serial Number and Product Key dialog box. In this case, enter
the required data, and then click Update.

2 In the Import the License dialog box, click Sign In.

3 On the Log In page, enter your Autodesk user ID and password and click
Log In.

4 On the License Import Confirmation page, click Finish.

The license is now imported to the computer and you can run your
Autodesk product on this computer. If you want to transfer the license
to another computer, repeat the export and import procedures.
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Troubleshoot a Stand-Alone License Error

Preserving a License When Hardware Changes

If you replace or reconfigure hardware on the computer where your Autodesk
product license resides, the stand-alone license might fail, with the result that
you will not be able to use your product.

To prevent damage to your product license, use the License Transfer Utility
to export your license file before changing the hardware. After the hardware
change, you can import the license file back. For information about using the
License Transfer Utility, see About the License Transfer Utility.

NOTE If you get a license error when you change your hardware, you may have
to reactivate your license. See Activation (page 64).

Reinstalling an Operating System

If you reinstall your operating system on the computer where your Autodesk
license resides, the license might fail. You will not be able to use your product.
To resolve a license error in this case, you must reactivate your product. See
Activation (page 64).

To prevent a license error when you reinstall an operating system

1 Make a backup copy of the following folder:
■ Library/Preferences/FLEXnet Publisher/FLEXnet

2 Reinstall the operating system and reinstall the Autodesk product.

3 Paste the license folder to the same location from which you originally
copied the folder in step 1.

You can now run your Autodesk product.

Changing the System Date and Time

Your product license allows for time changes to the system clock within two
days of the current time. If you set your system clock back more than two
days, the next time you start your product, you will receive a message that
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gives you the option of correcting the system clock. If you do not correct the
system clock, you receive a license error.

To prevent a license error due to a change in system date and time, ensure
that your computer's system date and time are accurate when you install and
activate your Autodesk product.

Preserving a License on a Re-imaged Computer

On a network license server, licenses are maintained on the server. No
additional steps are needed to preserve network licenses.

For a stand-alone license, you need to export the license before re-imaging
the computer. You can use the License Transfer Utility to export the license
to the Autodesk server. After the re-imaging, import the license to the correct
computer.

Network Licensing

Planning Your Network Licensing

Understanding License Server Models

This section explains the three possible server models that support the Network
License Manager. A server network can include Windows, Mac OS X, and
Linux servers in any combination. Advantages and disadvantages of each
model are presented to help you decide which one best suits your needs. When
you purchase a network license, you specify which server model you will use.

Single License Server Model

In the single license server model, the Network License Manager is installed
on a single server, so license management and activity is restricted to this
server. A single license file represents the total number of licenses available
on the server.
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NOTE In most cases, you can use a single license server installed on the same
machine as Smoke.

Advantages of the Single License Server Model
■ Because all license management takes place on a single server, you have

just one point of administration and one point of failure.

■ Of the three license server models, this configuration requires the least
amount of maintenance.

Disadvantage of the Single License Server Model
■ If the single license server fails, the Autodesk product cannot run until the

server is back online.

Distributed License Server Model

In the distributed license server model, licenses are distributed across more
than one server. A unique license file is required for each server. To create a
distributed license server, you must run the Network License Manager on each
server that is part of the distributed server pool.

Advantages of the Distributed License Server Model
■ Servers can be distributed across a wide area network (WAN); they do not

need to exist on the same subnet.

■ If one server in the distributed server pool fails, the licenses on the
remaining servers are still available.

■ If you need to replace a server in the distributed server pool, you do not
need to rebuild the entire pool.

■ Server replacement is easier than in a redundant server pool, where you
must reactivate the entire pool.

Disadvantages of the Distributed License Server Model
■ If a server in the distributed server pool fails, the licenses on that server

are unavailable.

■ This model can require more time for setup and maintenance than other
models.
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Redundant License Server Model

In the redundant license server model, three servers are configured to
authenticate license files. Licenses can be monitored and issued as long as at
least two license servers are still functional. The Network License Manager is
installed on each server, and the license file on each server is the same.

In the redundant license server model, all servers must reside on the same
subnet and have consistent network communications. (Slow, erratic, or dial-up
connections are not supported.)

Advantage of the Redundant License Server Model
■ If one of the three servers fails, all licenses that are managed in the server

pool are still available.

Disadvantages of the Redundant License Server Model
■ If more than one server fails, no licenses are available.

■ All three servers must reside on the same subnet and have reliable network
communications. The redundant server pool does not provide network
fault tolerance.

■ If one of the three servers is replaced, the complete redundant server pool
must be rebuilt.

■ If your Autodesk product supports license borrowing, and licenses are
borrowed from a redundant license server pool, you must restart the license
server after you stop the Network License Manager.

Windows System Requirements for the Network
License Manager

NOTE The Network License Manager supports Ethernet network configurations
only.

Hardware and software requirements for the network license server

RequirementHardware/Software

Windows® 7® 32-bitOperating System

Windows 7 64-bit

■ Windows 7 Home Premium

Network Licensing | 73



Hardware and software requirements for the network license server

RequirementHardware/Software

■ Windows 7 Professional

■ Windows 7 Ultimate

■ Windows 7 Enterprise

Windows Vista ® 32-bit SP2 or later
Windows Vista 64-bit SP2 or later

■ Windows Vista Enterprise

■ Windows Vista Business

■ Windows Vista Ultimate

■ Windows Vista Home Premium and Basic (32-bit)

■ Windows Vista Home Premium (64-bit)

Windows XP 32-bit SP2 or later
Windows XP 64-bit SP2 or later

■ Windows XP Home

■ Windows XP Professional

Windows Server 32-bit SP1 or later
Windows Server 64-bit SP1 or later

■ Windows 2008 Server R2

■ Windows 2008 Server

■ Windows 2003 Server R2

■ Windows 2003 Server

Intel® Pentium® III or higherComputer/processor

450 MHz (minimum)

Compatible with existing Ethernet network infrastructureNetwork interface card

NOTE The Network License Manager supports multiple network interface
cards, but at least one must be an Ethernet card.
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Hardware and software requirements for the network license server

RequirementHardware/Software

TCP/IPCommunication protocol

NOTE The Network License Manager uses TCP packet types.

Internet Explorer® 6.1Browsers

Internet Explorer 7
Internet Explorer 8
Internet Explorer 9

11.9.0.0FLEXnet

Virtual Machine Support

Virtual OSVirtualizerHardware

Vista 64-bit or 32-bit, Windows XP 32-
bit, Windows 7 32-bit (Home Premi-

Windows 2008 or Windows 2003

R2 servers running on VMware®
Intel PC 64

um, Professional, Ultimate, and Enter-ESX3.5 Update 3 (License Manager
Only) prise), Windows 7 64-bit, Windows

Server 64-bit or 32-bit.

Linux System Requirements for the Network
License Manager

NOTE The Network License Manager supports Ethernet network configurations
only.

Linux hardware and software requirements for the network license server

RequirementHardware/Software

Linux® 64-bit or 32-bitOperating system

Red Hat® Enterprise Linux 5.0 WS (U4)
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Linux hardware and software requirements for the network license server

RequirementHardware/Software

Intel Pentium 3 or higherComputer/processor
450 MHz (minimum)

Compatible with existing Ethernet network infrastructureNetwork interface card

NOTE The Network License Manager supports multiple network interface
cards, but at least one must be an Ethernet card.

TCP/IPCommunication protocol

NOTE The Network License Manager uses TCP packet types

11.9.0.0FLEXnet

Mac OS X System Requirements for the Network
License Manager

NOTE The Network License Manager supports Ethernet network configurations
only.

Mac OS X hardware and software requirements for the network license server

RequirementHardware/Software

Mac OS® X version 10.5.3 and higherOperating system

Intel MacComputer/processor

Compatible with existing Ethernet network infrastructureNetwork interface card

NOTE The Network License Manager supports multiple network interface
cards, but at least one must be an Ethernet card.

TCP/IPCommunication protocol
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Mac OS X hardware and software requirements for the network license server

RequirementHardware/Software

NOTE The Network License Manager uses TCP packet types

Safari 3.2.x and higherBrowsers

11.9.0.0FLEXnet

Understanding Your Network License

How Your License Works

When you start an Autodesk product, it requests a license from the license
server through the TCP/IP network . If the number of available licenses has
not been exceeded, the Network License Manager assigns a license to the
computer, and the number of available licenses on the license server is reduced
by one.

Likewise, when you exit a product, the license returns to the Network License
Manager. If you run multiple sessions of an Autodesk product on an individual
computer, only one license is used. When the last session is closed, the license
is released.

The following three processes manage the distribution and availability of
licenses:
■ License manager daemon (lmgrd or lmgrd.exe) handles the original

contact with the application, and then passes the connection to the vendor
daemon. By using this approach, a single lmgrd daemon can be used by
multiple software vendors to provide license authentication. The lmgrd
daemon starts and restarts the vendor daemons as needed.

■ Autodesk vendor daemon (adskflex or adskflex.exe) tracks the Autodesk
licenses that are checked out and the computers that are using them. Each
software vendor has a unique vendor daemon to manage vendor-specific
licensing.
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NOTE If the adskflex vendor daemon terminates for any reason, all users lose
their licenses until lmgrd restarts the vendor daemon or until the problem
causing the termination is resolved.

■ License file is a text file that has vendor-specific license information.

Interpreting Your License File

The network license file you receive from Autodesk contains licensing
information required for a network installation. You obtain license file data
when you register your Autodesk product.

The license file contains information about network server nodes and vendor
daemons. It also contains an encrypted digital signature that is created when
Autodesk generates the file.

The license file configures network license servers to manage licenses. When
creating a deployment, the network license server name(s) are specified so
that each product instance knows which server(s) to contact to obtain a license.
The network license server(s) must be accessible to every user who runs one
or more products that require a network license.

The following table defines each license file parameter. For more information,
see the License Administration Guide, installed with the Network License
Manager.

Definitions of license file parameters

ExampleDefinitionParameterLine

LABSERVERHost name of the server where the
Network License Manager resides

Host NameSERVER

03D054C0149BEthernet address of the server where
the Network License Manager resides

Host ID

[None]USE_SERVER

adskflex.exeName of the server-side Autodesk
vendor daemon

Vendor DaemonVENDOR
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Definitions of license file parameters

ExampleDefinitionParameterLine

port=2080Network port number reserved and
assigned for use only by Autodesk

Port Number

products running the Autodesk
vendor daemon

SERIES_1Name of feature code groupNamePACKAGE

1.000Internal version number referenceVersion

COMPONENTS=
"526000REVIT_9_OF\

List of feature codes supported in the
package

COMPONENTS

51200ACD_2007_OF\
513001INVBUN_11_OF"

OPTIONS=SUITEOPTIONS

SUPERSEDEReplacement for any existing Incre-
ment line of the same feature code

SUPERSEDE

from any license files on the same li-
cense server that have a date earlier
than the defined Issue Date

SIGN=0 SIGN2=0Encrypted signature used to authen-
ticate the attributes of the license file

SIGN

51200ACD_2007_0FProduct supported by the license fileFeature CodeINCREMENT

permanentAmount of time the licenses are
available

Expiration Date

25Number of licenses supported by the
license file

Number of Licenses
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Definitions of license file parameters

ExampleDefinitionParameterLine

COMMERCIALLicense usage type and license beha-
vior of the product that is supported
by the license file

VENDOR_STRING

BORROW=4320Definition of the license borrowing
period for the licenses defined under
the same increment line.

BORROW

In this example, the maximum period
that licenses can be borrowed is 4320
hours (180 days), unless otherwise
noted.
License borrowing is disabled when
this parameter is absent in the license
file.

DUP_GROUP=UHDefinition of multiple license requests
when the same user and same host
share the same license

DUP_GROUP

15-jul-2010Date that the license file was gener-
ated by Autodesk

ISSUED

123-12345678Serial number of the Autodesk
product

Serial Number

SIGN=6E88EFA8D44CEncrypted signature used to authen-
ticate the attributes of the license file

SIGN

License File Examples

The Autodesk network license file contents reflect the license server
configuration and the licensed products, as shown in the examples provided.
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Example of a License File Not Specific to a Product

Here is an example of the contents of a license file and the parameters
associated with each line:

SERVER
ServerName HostID USE_SERVER VENDOR
adskflex port=portnumber INCREMENT
feature_code Adskflex Version ExpDate NumberofLicenses \
VENDOR_STRING=UsageType:Behavior
BORROW=4320 SUPERSEDE \
DUP_GROUP=DupGrp ISSUED=IssueDate SN=SerialNumber SIGN=
\

Example of a License File for a Single or
Distributed Server

Here is an example of a completed license file for a single or distributed license
server model:

SERVER
XXHP0528 0019bbd68993USE_SERVER VENDOR
adskflex port=2080 INCREMENT
57600ACD_2009_0F adskflex 1.000 permanent 5 \
VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE
\
DUP_GROUP=UH ISSUED=09-Jan-2008 SN=123-12345678 SIGN="1393
\
E368 816E D417 C1CD 7DBD 7B90 1354 D6F0 48FE EBB8 9C84 C3AF
\
7D79 BEE1 0181 0655 76FF 996C B707 14B5 D4DE A3FE 0B2D 2D36
\
057C A579 7866 26BF 44E2" SIGN2="1280 943B 53A7 9B93 E00B
D967 \
D821 BD37 BE6D B78A F074 B223 88AA 242C DD0A 1292 D56F 4108
\
62CD FA35 E365 0736 A011 7833 8B35 7BFF DAD8 34A8 452F
2EB4"
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Example of a License File for a Redundant Server

Here is an example of a completed license file for a redundant license server
model:

SERVER
CCN12378042 001cc4874b03 27005SERVER
XXHP0528 0019bbd68993 27005SERVER
CCN12378043 001cc4874b10 27005USE_SERVERVENDOR
adskflex port=2080INCREMENT
57600ACD_2009_0F adskflex 1.000 permanent 5 \
VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE
\
DUP_GROUP=UH ISSUED=10-Jan-2008 SN=123-12345678 SIGN="11C4
\
CA79 07FC 7AD0 409A 6E04 6E98 D76C 197C 0416 076C B211 1CDD
\
D0AB 698B 16BF 7A0E D4F8 1CFE 2985 644F 64CD CECE 0DDB 5951
\
3262 7C31 13A8 F08F 55B2" SIGN2="19A6 FDA3 2ED5 5301 8675
7B81 \
1B0E 451B 19F1 1A99 C8E9 CBA6 8CB3 6AC3 8B38 1519 13F2 2373
\
82AE 55E5 1A25 4952 4458 F3A2 6F28 D25D 1DC0 E066 209B
0953"

NOTE The redundant server model requires the addition of a port number (the
default is 27005) for each server.

Example of a License File for Combined Autodesk
Product Versions

You can combine a license file for different releases of the same Autodesk
product or for different Autodesk products, and run all products from one
license server.

Here is an example of the contents of a combined license file for AutoCAD 2008
and AutoCAD 2009:

SERVER
XXHP0528 0019bbd68993USE_SERVER VENDOR
adskflex port=2080 INCREMENT
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57600ACD_2009_0F adskflex 1.000 permanent 5 \
VENDOR_STRING=commercial:permanent
BORROW=4320 SUPERSEDE \
DUP_GROUP=UH ISSUED=09-Jan-2008 SN=123-12345678 SIGN="1393
\
E368 816E D417 C1CD 7DBD 7B90 1354 D6F0 48FE EBB8 9C84 C3AF
\
7D79 BEE1 0181 0655 76FF 996C B707 14B5 D4DE A3FE 0B2D 2D36
\
057C A579 7866 26BF 44E2" SIGN2="1280 943B 53A7 9B93 E00B
D967 \
D821 BD37 BE6D B78A F074 B223 88AA 242C DD0A 1292 D56F 4108
\
62CD FA35 E365 0736 A011 7833 8B35 7BFF DAD8 34A8 452F
2EB4"
INCREMENT 54600ACD_2008_0F adskflex 1.000 permanent 3 \
VENDOR_STRING=commercial:permanent
BORROW=4320 SUPERSEDE \
DUP_GROUP=UH ISSUED=09-Jan-2008 SN=123-12345678 SIGN="1E6E
\
4B61 5712 4766 92A0 6782 9EF4 3F47 56A1 1F38 6DE8 C0C7 90AC
\
7289 152E 0EA2 CC0D 3F10 577A 0489 CEB6 10D5 FBCC B552 0C9D
\
5966 91A6 59F0 2788 FACE" SIGN2="1DDF 3B9D 3392 71D5 AB08
7E05 \
8497 111E 092F 0E54 8DC2 2BED 17C2 2CC1 981B 0EC2 BC15 8F00
\
C79A ABFD 2136 BABA 2EDF E941 EA53 32C6 597F F805 5A8A
599A"

Package License File Types and Examples

Autodesk offers a package license file option, which allows the use of a suite
of products that are packaged and sold together. The package license file
contains a set number of licenses for four different versions of your software.
Running an instance of any one of the versions uses one license in the package.
Packaged license files support prior versioning for subscription users. Package
license files operate under the following guidelines:
■ Package license files come with the current version of the software and

three previous versions of the same product.
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■ License files can be combined with license files for different products. For
more information about combining license files, see Example of a Package
License File for Combined Autodesk Product Versions (page 86).

■ Package license files cannot be combined with non-package license files
for product versions contained in the package. For example, you cannot
combine an Autodesk  2009 package license file with a regular license file
for an Autodesk Product 2008, 2007, or 2006.

■ Both the PACKAGE and INCREMENT sections of the license are required
for licensing to work properly. When you combine license files, be sure to
include both of these sections.

■ License borrowing, option files, and licensing cascading work the same
for package licenses as they do for regular license files.

■ A new license file supersedes an older one.

Example of a Package License File for a Single or
Distributed Server

Here is an example of a completed package license file for a single or distributed
license server model:

SERVER
Server1 1a34567c90d2USE_SERVER VENDOR
adskflex port=2080 PACKAGE
SERIES_1 adskflex 1.000 COMPONENTS="54700REVIT_2009_0F \
54600ACD_2009_0F 51300INVBUN_11_0F" OPTIONS=SUITE SUPERSEDE
\
ISSUED=09-Jan-2008 SIGN="1707 9EAC CBCB 2405 692E 4A89 \
AA26 30CC 2AC2 D6B3 A61B AB5E 492E 3EBD 0B48 4E75 193A
DA82" \
FC45 C009 E360 944A 14BA E99C 9B24 5A1B 4A44 083A BE5F 3827
\
SIGN2="004A FC90 AB47 3F6B 59BC 0E6D 6681 6971 A76A BA52
98E2 \
5671 26B3 0E78 791B 109F 0591 7DC3 F09F 4D8D 4FB7 E341 4A03
\
CD68 1D77 27F8 8555 9CF7 DEDD 9380"
INCREMENT SERIES_1 adskflex 1.000 permanent 100 \
VENDOR_STRING=commercial:permanent BORROW=4320 DUP_GROUP=UH
\
SUITE_DUP_GROUP=UHV SN=123-12345678 SIGN="1707 9EAC CBCB
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\
692E 4A89 FC45 C009 E360 944A 14BA E99C 9B24 5A1B 4A44 BE5F
\
3827 AA26 30CC 2AC2 D6B3 A61B AB5E 492E 3EBD 0B48 DA82" \
SIGN2="004A FC90 AB47 3F6B 59BC 0E6D 6681 6971 A76A BA52
\
5671 26B3 0E78 791B 109F 0591 7DC3 F09F 4D8D 4FB7 E341 4A03
\
CD68 1D77 27F8 8555 9CF7 DEDD 9380"

Example of a Package License File for a Redundant
Server

Here is an example of a completed package license file for a redundant license
server model:

SERVER
1a34567c90d2 27005SERVER
2a34567c90d2 27005SERVER
3a34567c90d2 27005USE_SERVERVENDOR
adskflex port=2080PACKAGE
64300ACD_F adskflex 1.000 COMPONENTS="57600ACD_2009_0F \
54600ACD_2008_0F 51200ACD_2007_0F 48800ACD_2006_0F" \
OPTIONS=SUITE SUPERSEDE ISSUED=27-May-2008 SIGN="1092 05D8
\
A206 276B 2C84 EFAD ACA5 C54B 68A4 653E C61F 31DE C8CE B532
\
CFBB 0006 5388 347B FDD6 A3F4 B361 7FD4 CDE4 4AAC 0D11 B0EF
\
4B44 BFD6 3426 97DD" SIGN2="0670 B01A D060 0069 FF25 F1CD
D06B \
314E E7C9 3552 5FFA 4AC7 28A7 C897 F56A 19BB FB1C 754E 6704
\
DEEA AC4E F859 2E9B 64B6 0DD0 9CCE 9556 269F EAC0 2326"
INCREMENT 64300ACD_F adskflex 1.000 permanent 50 \
VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE
\
DUP_GROUP=UH SUITE_DUP_GROUP=UHV ISSUED=27-May-2008 \
SN=399-99999999 SIGN="1B5B 8D70 4CAD 32E5 9CA2 82E0 5C47
291C \
35AB 9B9C 5B3E 5067 F61B 4139 1B32 0716 1FD3 5105 A991 B78E
\
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9D1E 63AB BC23 0D1E B70C 2A05 E1C1 F605 ABB1 2EA8"
SIGN2="01D6 \
31F5 2951 4500 E5C8 058F 7490 9789 9EF4 CBED DA27 5F06 6780
\
9033 2018 0C3B E1E0 3580 E60E C2BB B4AB 8D6A 4245 3059 8CA6
\
2EFE DFAE 027F 2ABE 3F2B"

Example of a Package License File for Combined
Autodesk Product Versions

Here is an example of a completed package license file for combined Autodesk
product versions:

SERVER
servername 123456789111USE_SERVER VENDOR
adskflex port=2080 PACKAGE
64300ACD_F adskflex 1.000 COMPONENTS="57600ACD_2009_0F \
54600ACD_2008_0F 51200ACD_2007_0F 48800ACD_2006_0F" \
OPTIONS=SUITE SUPERSEDE ISSUED=25-Jun-2008 SIGN="03EF DE18
\
8046 0124 4EA4 6953 F82D 3169 7C24 D0DE E58E 8168 FFA3 D891
\
B43B 08D8 7E7F C6ED CBCC FE2A BB0A 4566 C2AE F1C1 D373 8348
\
E6E3 884A E398 1C78" SIGN2="07AC D696 8844 D19F AB00 8B75
53A3 \
2F76 91DF AED0 3231 1506 0E6B ADC6 C3B8 1797 93B5 9756 8C0F
\
8811 56E6 B2BA 0523 FE2E 82B7 1628 076F 173B F37C 7240"
INCREMENT 64300ACD_F adskflex 1.000 permanent 2 \
VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE
\
DUP_GROUP=UH SUITE_DUP_GROUP=UHV ISSUED=25-Jun-2008 \
SN=399-99999999 SIGN="1CCB E88D B819 8604 06FA 9AEE 42F1
CBEA \
37B9 3CFA A0A8 697F 9CB1 8354 6256 05ED 69D4 D2FF D512 6A2E
\
D5DD B722 EF5B 3172 BA95 4625 F8D3 DD24 BB39 6A58"
SIGN2="0DFF \
FA6F C378 20E0 2622 BE52 B434 F99F 2681 2B93 64F2 CE0C 7F4A
\
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7024 B3D1 051A 6920 72BD DE35 8920 E6A1 C8D6 AF23 7BE7 CC91
\
6916 70B1 9E80 AB07 1644"
PACKAGE 64800INVPRO_F adskflex 1.000 \
COMPONENTS="59600INVPRO_2009_0F \
55300INVPRO_2008_0F 51400INVPRO_11_0F 49000INVPRO_10_0F"
\
OPTIONS=SUITE SUPERSEDE ISSUED=25-Jun-2008 SIGN="1306 5990
\
F8A1 56FB 1D8A 9DA7 D6AE 8E9E F6EC 2862 367A 36E2 C5FB E6E1
\
4AAA 0128 8C2D 95FD 09B2 ABA1 6F98 A0A3 70DE 3220 6835 7E51
\
3849 9D81 8BDC 9DC1" SIGN2="0021 AA08 F2E7 8AEB 5345 341A
7E42 \
3001 B8C5 DFC2 6EB8 87C5 C04A AE43 A10F 1DA1 EF8A F0FA 10F5
\
AC81 1E22 789F A18D 650F 6BBB 563A BDA5 DD1C 82EC 27F6"
INCREMENT 64800INVPRO_F adskflex 1.000 permanent 2 \
VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE
\
DUP_GROUP=UH SUITE_DUP_GROUP=UHV ISSUED=25-Jun-2008 \
SN=399-99999966 SIGN="0BE4 51F4 570C DC48 5E66 F952 629E
EDF0 \
019C 6FF7 0509 1FF0 D4FB 3B16 1981 073F 31EC A241 8CB3 8782
\
E655 00C6 E097 D5EF B0D8 67D3 199D 699D 2E09 B16F"
SIGN2="1254 \
3E37 0CE4 F42D B7CD 858C 92FC A963 5274 770F 9354 FE29 E117
\
205D C632 0C4E AEC0 7501 9D9E FFEB D84D F154 16A1 E120 339A
\
FDBF 3F07 4477 B8B3 5DA4"

Losing Your Connection to the License Server

When an Autodesk product is running, it communicates with the license
server at regular intervals using a method known as the “heartbeat” signal. If
the heartbeat signal is lost, the server tries to reconnect. If the server cannot
reconnect, the user receives a license error.
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If the product stops working because it has lost a connection to the server,
you must shut down the product, and then restart it. Most Autodesk products
give you the opportunity to save open documents before shutting down. If
the problem causing the original loss of the heartbeat signal is resolved and
licenses are available on the server, you can restart your Autodesk product.

Running the Network License Manager

The Network License Manager is used to configure and manage the license
servers. When you create a deployment, the installer prompts you for
information about the license manager, such as license server model and server
name.

Install the Network License Manager

You can install the Network License Manager before or after you install the
products that will use it. Network License Manager must configure the license
servers before any products can obtain licenses and start running.

If an earlier version of the Network License Manager is already installed on
the computer, you should upgrade by installing the new Autodesk Network
License Manager.

Install the Network License Manager (Mac OS X)

To install the network license manager on Mac OS X:

1 Locate the Smoke installation media.

2 Open the Standalone Installers folder.

3 Start the Install License Server installation.

4 Follow the on-screen instructions to complete the installation.

Install the Network License Manager (Linux)

To install the network license manager (Linux):

1 Locate the Standalone Installer folder on the Smoke installation media.
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2 Copy the Burn folder to a Linux machine.

3 Log in as root.

4 Unzip the tar file. Type:

tar -xzvf Burn_*tar.gz

5 Open the Burn folder created when you unzipped the package.

6 Install Burn. Type:

./INSTALL_LICSERV

Follow the instructions in to complete the installation.

Obtain the Server Host Name and Host ID

Autodesk uses the server host name, host ID, and product serial number to
generate a license file.

To obtain the information, use one of the following procedures.

Mac or Linux Terminal Window Procedure for
Host Name and ID

To obtain the host name and ID using the Mac OS X or Linux terminal
window

1 Launch a Terminal window.

2 Go to the directory where lmutil is installed.

3 Retrieve the host name by entering the following in Terminal:

<prompt>./lmutil lmhostid -hostname

The host name is displayed.

4 Retrieve the host ID by entering the following in Terminal:

<prompt>./lmutil lmhostid

The twelve-character host ID is displayed.

5 Close the Terminal Window.
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Stop and Restart the License Server

Before you can perform any system maintenance, including uninstalling the
Autodesk License Manager on your license server, you must stop the license
server. When you have completed maintenance, you can restart the license
server.

To restart the license server (Mac OS X)

To restart the license server:

1 Open the License Server Configurator. You can find the License Server
Configurator in one of the following places:
■ If Smoke is installed on the same workstation: Applications/ Smoke

2011/Utilities

■ If Smoke is not installed on the workstation:
/Applications/Autodesk/Adlm

2 Do one of the following:
■ If the server is not running, click Start.

■ If the server is running, click Restart.
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To restart the license server (Linux)

Enter the following in Terminal:

/etc/init.d/license_server_adlm stop

/etc/init.d/license_server_adlm restart

Using Other Features of Network Licensing

License Borrowing

If you are using a network-licensed version of your Autodesk product and your
network administrator supports the license borrowing feature, you can borrow
a product license from your network license server to use the Autodesk product
for a specified time when your computer is not connected to the network.
Your license is automatically returned to the license server at the end of the
day on the return date you set when you borrow the license. You can also
return a license early. The maximum borrowing period is six months.

NOTE License borrowing does not apply to stand-alone licenses.

NOTE A limited number of licenses are available for borrowing. If you try to borrow
a license and are notified that no licenses are available, see your network
administrator for help.

Borrow a License

With a borrowed license, you can run your Autodesk product with your
computer disconnected from the network until your borrowing period ends.
If you don't remember when a license expires, you can check the date by
placing your cursor over the Borrowing icon in your Autodesk product's status
tray or by clicking Help  ➤  About and consulting the Product License
Information dialog box.

When the borrowing period expires, the borrowed license is automatically
returned to the license server. When your computer is reconnected to the

Network Licensing | 91



network, you can run your Autodesk product from the network or borrow a
license again.

Interaction with Other License-Borrowing Tools

Using the license-borrowing feature in your Autodesk product is the
recommended way to borrow a license. Some third-party borrowing tools may
also be available to you, but these tools are not supported or compatible with
the license-borrowing feature in your Autodesk product. Other third-party or
legacy license-borrowing tools that may be available to you are the Autodesk
License-Borrowing utility (shipped with Autodesk products) and the borrowing
feature in LMTOOLS utility, a component of the Autodesk Network License
Manager on Windows servers.

If another license-borrowing tool is active when you attempt to use the license
borrowing feature, you should proceed as follows to borrow a license for your
Autodesk product:
■ If you run the Autodesk License-Borrowing utility that shipped with your

Autodesk product and then turn on the borrowing flag for the Adskflex
option or the All option, a license can be borrowed when you start your
Autodesk product. However, you cannot return a license until you exit
and then restart your Autodesk product.

■ On a Windows server, if borrowing is set in the LMTOOLS utility for all
products, you can either use the other tool to borrow licenses for your
Autodesk product, or stop the borrowing process in LMTOOLS utility, and
then use the license-borrowing feature in your Autodesk product.

■ If borrowing is set in LMTOOLS utility for non-Autodesk products only,
you must stop the borrowing process in LMTOOLS utility. You can then
use the license-borrowing feature to borrow licenses for your Autodesk
product. If you do not stop the borrowing process in LMTOOLS utility,
the license borrowing feature will not function.

To borrow a license using the Help menu

1 Click Help ➤ About ➤ Product Information.

2 In the Product License Information window, click Borrow License.

3 In the Borrow a License window, on the calendar, click the date when
you want to return the license.

This date must be within the valid date range set by your network
administrator. The valid date range is displayed in this window.

4 Click Borrow License.
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5 In the License Borrowed message, click OK. The license is borrowed, and
you can now use the Autodesk product with your computer disconnected
from the network.

BORROWLICENSE Command

Use this command to borrow a product license from the network license server
so that you can run the Autodesk product disconnected from the network.

Help menu: About  ➤  Product Information  ➤  Borrow License

The Borrow a License window is displayed, presenting the following options:
Calendar Sets the date when you plan to return a borrowed license. The return
date must be within the range specified by your network administrator.

Borrow a License Borrows the license from the network license server based
on the specified return date .

Cancel Cancels the borrowing action; no license is borrowed.

Return a License

Your borrowed network license is automatically returned to the network license
server on the day that the license expires. You can return a license earlier than
the expiry date, but to do this, your computer must be connected to the
network license server.

Once a borrowed license is returned, you can borrow a license again as long
as your computer is connected to the network license server and a license is
available on the server.

To return a borrowed license early:

■ Click Help menu ➤ About ➤ Product Information. In the Product License
Information dialog box, click Return License, and then click Yes.

NOTE To use the status tray to return a borrowed license early, the display settings
for the status tray must be turned on. To turn on the display settings, right-click
an empty area on the status bar. Click Tray Settings.

Your license is returned to the network license server.
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To check the license expiration date:

■ Click Help menu  ➤  About  ➤  Product Information. In the Product License
Information dialog box, see the License Expiration Date.

RETURNLICENSE Command

Use this command to return a borrowed Autodesk product license earlier than
the return date specified when you borrowed the license.

Help menu: About  ➤  Product Information  ➤  Return License

FLEXnet Configuration Tools

The Network License Manager uses FLEXnet® license management technology
from Flexera Software™. FLEXnet provides administrative tools that help to
simplify management of network licenses. You can use FLEXnet tools to
monitor network license status, reset licenses lost during a system failure,
troubleshoot license servers, and update existing license files.

Update FLEXnet from a Previous Version

Beginning with this release, Autodesk products require FLEXnet version 11.9.0.0
or later. If you are currently using an earlier version of FLEXnet, you need to
update.

NOTE If the server where you plan to install the Autodesk Network License
Manager has FLEXnet installed for another product, make sure that the version of
lmgrd.exe (Windows) or lmgrd (Mac or Linux) is the most current version.

Mac OS X and Linux Procedures to Update
FLEXnet

To determine the installed version of FLEXnet, you need to verify the version
of the following files:
■ lmgrd
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■ lmutil

■ adskflex

NOTE Version 11.9.0.0 of the FLEXnet license manager that ships with Autodesk
products is backwards compatible, and will administer licenses for products from
versions 2002 through 2012. Please note that Autodesk products older than version
2005 are no longer supported.

To verify the version of Mac OS X or Linux tools

You should be logged in with the same user ID you used when installing the
FLEXnet files, for example, /Users/<userid>/adsknlm (Mac OS X) or
/home/<userid>/adsknlm (Linux).

Enter the following commands in the terminal window/prompt:

<prompt>./lmutil -v
<prompt>./lmgrd -v
<prompt>./adskflex -v

The output of each command will look similar to this example:

Copyright
© 1989-2010 Macrovision Europe Ltd. And/or Macrovision
Corporation.
All Rights reserved.
lmutil v11.5.0.0 build 56285 i86_mac10

To update FLEXnet in Mac OS X

You should be logged in with the same user ID you used when installing the
FLEXnet files, for example, /Users/<userid>/adsknlm. The logged in user ID
should be in the sudoers list to execute some of the following commands.

1 Back up your license files.

2 Stop the Autodesk Network License Manager service by entering the
following in Terminal:

sudo ./lmutil lmdown -q -force

3 Note the location where the Network License Manager is installed and
then uninstall the Network License Manager by entering the standard
Mac OS X commands, for example, rm.

4 Install the Network License Manager. Copy the new version of the
FLEXnet network license manager files (lmgrd, adskflex, and lmutil) to

Network Licensing | 95



the location recommended when you configured your license server, for
example, /Users/<user id>/adsknlm.

5 Start the Autodesk Network License Manager service by entering the
following string in Terminal.

NOTE In the string, replace acad.lic and debug.log with your license file name
and log file name.

sudo ./lmgrd -c acad.lic -l debug.log

To update FLEXnet in Linux

You should be logged in with the same user ID you used when installing the
FLEXnet files, for example, /home/<userid>/adsknlm. The logged in user ID
should be in the sudoers list to execute some of the following commands.

1 Back up your license files.

2 Stop the Autodesk Network License Manager service by entering the
following in Terminal:

./lmutil lmdown -q -force

3 Note the location where the Network License Manager is installed and
then uninstall the Network License Manager by entering the standard
Linux commands, for example, rm.

4 Install the Network License Manager. Copy the new version of the
FLEXnet network license manager files (lmgrd, adskflex, and lmutil) to
the location recommended when you configured your license server, for
example, /home/<user id>/adsknlm.

5 Start the Autodesk Network License Manager service by entering the
following string in Terminal.

NOTE In the string, replace acad.lic and debug.log with your license file name
and log file name.

./lmgrd -c acad.lic -l debug.log

Set Up and Use an Options File

With an options file, you set configuration options that determine how a
license server manages licenses. An options file sets parameters that the license
file reads and the lmgrd program executes.
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The options file on each server specifies the license-handling behavior for that
server. By managing the contents of the options files, you can specify the
same behavior on all license servers, or implement particular differences among
the servers.

NOTE For options file changes to take effect on a license server, you must save
the options file, and then reread the license file.

Use the options file to set parameters for the following server-related features:
■ Report log file

■ License borrowing

■ License timeout

You can also set up advanced license parameters, such as reserving a license,
restricting license usage, or defining groups of users. To learn more about
setting advanced options file parameters, see the FLEXnet documentation.
This documentation is installed on the license server, in the Network License
Manager directory.

Create an Options File

NOTE For options file changes to take effect on a license server, you must save
the options file, and then reread the license file.

To create an options file on a Windows platform

You should be logged in with Administrator permissions when working with
the LMTOOLS utility.

1 Open a text editor, enter the parameters you want, and then save the
document as a file named adskflex.opt to the same location where you
saved the license file.

NOTE Make sure you save the file with the extension .opt. The default
extension .txt is not recognized by the Network License Manager.

2 Click Start ➤  All Programs  ➤  Autodesk  ➤  Network License Manager
 ➤  LMTOOLS Utility.

3 In the LMTOOLS utility, on the Start/Stop/Reread tab, click Reread License
File.

4 Close LMTOOLS.
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To create an options file on a Mac OS X or Linux platform

1 Open a text editor, enter the parameters you want, and then save the
document as a file named adskflex.opt to the same location where you
saved the license file.

NOTE Make sure you save the file with the extension .opt. The default
extension .txt is not recognized by the Network License Manager.

2 launch a Terminal window, navigate to the Autodesk Network License
Manager folder, and enter the following string:

./lmutil lmreread -c @hostname-all

3 Close the Terminal window.

Create a Report Log

In the options file, you can create a report log file, which is a compressed,
encrypted file that provides usage reports on license activity.

Windows Procedure

To create a report log

1 In a text editor, open the options file, adskflex.opt.

2 In the options file, enter the following syntax on its own line
(REPORTLOG must be uppercase):

REPORTLOG [+]report_log_path

For example, the syntax REPORTLOG +"c:\My Documents\report.rl"
means that a report log named report.rl is located in the folder c:\My
Documents.

NOTE Path names that contain spaces must be enclosed in quotation marks.

In the REPORTLOG syntax, “[+]” means that entries to the log file you
create are appended rather than replaced each time the Network License
Manager is restarted. It is recommended that you use this option to retain
a history of log entries.
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Mac OS X or Linux Procedure

To create a report log

1 In a text editor, open the options file, adskflex.opt.

2 In the options file, enter the following syntax on its own line
(REPORTLOG must be uppercase):

REPORTLOG [+]report_log_path

For example, the syntax REPORTLOG +"/Users/<user id>/NLM/report.rl"
means that a report log named report.rl is located in the folder /Users/<user
id>/NLM.

NOTE Path names that contain spaces must be enclosed in quotation marks.

In the REPORTLOG syntax, “[+]” means that entries to the log file you
create are appended rather than replaced each time the Network License
Manager is restarted. It is recommended that you use this option to retain
a history of log entries.

Configure License Borrowing with the Options
File

If your Autodesk product supports the license borrowing feature, you can use
the options file to configure license borrowing options. For example, define
the maximum number of licenses that can be borrowed from your network
at any one time. In addition, define which users can borrow an Autodesk
product license. Licenses are assigned to users, not computers.

For more information on license borrowing, see License Borrowing (page 91).

NOTE If your Autodesk product licenses are borrowed from a redundant license
server pool, you must restart the license server after you stop the Network License
Manager.

At the end of a borrow period, the borrowed license is automatically disabled
on the user's computer and becomes available again on the license server.
Users can also return a license before a borrow period has ended.
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To set license borrowing parameters

1 In the options file, enter the following syntax on its own line
(BORROW_LOWWATER must be uppercase):

BORROW_LOWWATER feature_code n

In the BORROW syntax, “feature_code” is the name of the product in
the license file, and “n” is the minimum number of licenses that must
remain on the server. When this number is reached, no more licenses
can be borrowed.

For example, the syntax BORROW_LOWWATER Autodesk_f1 3 means
that for the product Autodesk_f1, when only three licenses remain on
the license server, no licenses can be borrowed.

2 Enter the following syntax on the next line (MAX_BORROW_HOURS
must be uppercase):

MAX_BORROW_HOURS feature_code n

In this syntax, “n” is the number of hours that a license can be borrowed.

For example, the syntax MAX_BORROW_HOURS Autodesk_f1 360 means
that for product Autodesk_f1, licenses can be borrowed for 360 hours,
or 15 days.

NOTE Licenses are borrowed in increments of 24 hours only. Any number
that is more than a 24-hour increment is not used. For example, the number
365 would be rounded down to 360 hours, or 15 days.

For more information about setting up the license borrowing feature, see the
FLEXnet documentation. On a Windows computer, go to this folder:
C:\Program Files\Autodesk Network License Manager.

NOTE To borrow a license in an Autodesk product, click Help ➤ About ➤ Product
Information ➤ Borrow License. Alternatively, enter borrowlicense on the product
command line. Help for this feature is available in the Borrow a License for [Product
Name] window and in C:\Program Files\[Product Name]\Help\adsk_brw.chm.

Set Up License Timeout

License timeout is set in the options file to determine how long a product
session can be idle before the license is reclaimed by the license server. When
you set this flag in the options file, a user's license is reclaimed by the license
server if the product is idle on a computer for more than the timeout period
you define.

100 | Chapter 6   Licensing



IMPORTANT License timeout is not supported by all Autodesk products.

If a user's license is lost because of the idle timeout, the product attempts to
claim a new license once the user uses the product again. If no license is
available, the user can save work before the product shuts down.

You can use the TIMEOUT parameter to set individual license timeouts for
each Autodesk product on your computer, or use the TIMEOUTALL parameter
to set one license timeout for all Autodesk products on your computer.

To set license timeout parameters

■ For individual Autodesk products: In the options file, enter the following
syntax on its own line (TIMEOUT must be uppercase):

TIMEOUT feature_code n

In the TIMEOUT syntax, “feature_code” is the name of the product (referred
to in the INCREMENT line in the license file), and “n” is the number of
seconds before an inactive license is reclaimed by the license server.

For example, the syntax TIMEOUT Autodesk_f1 7200 means that for the
product Autodesk_f1, the license timeout period is 7200 seconds, or two
hours.

■ For all Autodesk products: In the options file, enter the following syntax
on its own line (TIMEOUTALL must be uppercase):

TIMEOUTALL n

In the TIMEOUTALL syntax, “n” is the number of seconds before an
inactive license is reclaimed by the license server.

For example, the syntax TIMEOUTALL 7200 means that for all Autodesk
products, the license timeout period is 7200 seconds, or two hours.

For more information about using the license timeout feature, see the FLEXnet
documentation. On a Windows server, it is located in C:\Program Files\Autodesk
Network License Manager folder. On a Mac OS X or Linux server, the
documentation is installed in the Network License Manager directory.
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